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PURPOSE

EloTalk is a Windows CE application program. It executes only on CE. It is essentially a sophisticated control panel for Elo touchscreens intended for use by CE system developers rather than end users. It affords typical control panel functions-- such as setting the touch mode to click on touch, click on untouch, or mouse emulation-- but it also affords advanced functions, such as direct communication with a touchscreen via Elo's SmartSet protocol.

EloTalk fills a special need of embedded system developers to be able to easily experiment with touchscreen configuration options. With general-purpose operating systems, a relatively sophisticated control panel can be presented to the end user, who can be assumed computer-literate and aware of the consequences of changes. Embedded systems rarely can make such assumptions and typically accord the end user limited configuration options. However, without control panel-like functions, the CE system developer can test configuration options only by modifying registry source files, rebuilding and reloading the OS image, and restarting the target system. This problem could be addressed by a more limited standard control panel included in the OS during development but excluded from the production build. However, since EloTalk is intended for the developer anyway, making it the one means of controlling all configuration functions and providing specialized developer functions simplifies the development environment without reducing capability.

GENERAL USAGE

BUILD

The CE system developer treats EloTalk like any other application except that it is built into the OS image during development but excluded in the production build unless end users can be trusted with the power that it grants. This is simple if EloTalk is included as a project rather than a library component [Appendix A: Building Os With Elo Programs]. Under CE5.0 Platform Builder, open Platform > Settings > Image Settings. Select EloTalk and check the "Exclude from image" box. Then Build OS > Make Run-Time Image. Under CE6.0 VS PB plug-in, in Solution Explorer (tabbed window) right-click the platform-project name. Click Properties. Expand Configuration Properties. Click Subproject Image Settings. Double-click EloTalk. Check Exclude from Image. Then Build > Make Run-Time Image.

Developers using the component library method of including Elo touchscreen programs in their OS must delete or remove EloTalk in the CE5 OSDesignView or CE6 Catalog Items View and rebuild the entire OS (CE5 Build OS > Build and Sysgen or CE6 Build > Build Solution) which takes much longer than rebuilding the image.

CEPC BOOT DISC

EloTalk is included in Elo's CEPC boot disc, which boots a standard PC into Windows CE with Elo serial and USB touch programs, affording a means of testing, configuring, and evaluating Elo's CE programs and touchscreens without specialized facilities or having to build the OS.

CONFIGURATION AND REGISTRY

EloTalk comprises tabbed dialogs for specific topics related to touchscreen operation. The dialogs are touch, sound, calib (calibration), smartSet, and system. Each dialog mainly comprises controls for setting touchscreen options. Controls may be activated by touch, mouse, or keyboard (hot key in some cases). All selections take effect either immediately or when a button such as "write" or "apply" is activated.

For some configuration options, EloTalk writes to the registry and the touchscreen driver automatically responds to changes. For others, EloTalk communicates directly with the driver. In all cases, either EloTalk or the driver writes configuration changes to the registry. Thus, the registry always completely describes the current touchscreen configuration. See [Appendix B: Elo Touchscreen Registry Values]. While it is helpful just to see the effect of options, CE system developers need to capture this configuration to include it in their design (reg files). 

Some registry settings have fairly obvious meaning; the relationship between others and touchscreen operation may be incomprehensible. EloTalk's "system" dialog addresses this with a "save registry" button. Activating this causes all registry settings related to touchscreen operation to be written into the eloreg.txt file located in the (CE system) \windows directory. The information is arranged and formatted for pasting directly into system design reg files. 

In many CE systems, files written at run-time are not persistent and there might be no means of retrieving eloreg.txt. In a full development environment, the host computer running Platform Builder can copy the file. Under CE5, this is done by Tools > Remote File Viewer > Default Device. Under CE6, use Target > RemoteTools > File Viewer. Select Windows\eloreg.txt and press the tool button Import File From Device (down arrow in the toolbar). In a CE system with network capability, the file can be sent to a server. In a system with support for USB Function Clients > Mass Storage, the file can be copied to a USB flash drive.

TABBED DIALOG COMMON FEATURES

OPEN AND CLOSE

All dialog tabs are visible when any tabbed dialog is open and any dialog can be opened at any time by clicking (mouse or touch) its tab button. If no dialog is currently open, hot keys t, s, c, m, and y (with and without shift, Alt, Ctrl) open the touch, sound, calibration, smartSet, and system dialogs. When a dialog is open, it receives all hot key notifications.

In the upper right corner of every tabbed dialog is an X button, which closes the dialog. Pressing the Esc key closes the open dialog unless the focus is in an edit field.

TOUCH DEVICE SELECTION

Near the upper right corner of every tabbed dialog is a drop-down list box from which a device can be selected from all serial touchscreens listed in the registry and all currently connected USB touchscreens. When EloTalk starts it probes the CE system for touchscreens. If a serial touchscreen is listed in the registry but does not respond, EloTalk reports an error once. It does not repeat this warning unless it is closed and reopened. It reports no errors for disconnected USB touchscreens.

Each tabbed dialog contains controls for modifying and testing touchscreen behavior. Most of these apply only to the currently selected device. If the system contains multiple touchscreens, it is possible to operate a dialog from one touchscreen even when a different one is selected. This can be confusing and should be avoided, especially in the touch and sound dialogs.

ELO UPDOWN CONTROLS

Many of the dialogs contain Elo UpDown controls, which operate similarly to Microsoft up/down controls but are optimized for operation by touch. Each of these comprises three elements, a down button (<), an edit field, and an up button (>). The edit field accepts keyboard input and treats the Enter key as an activation command. When the edit field has the keyboard focus, arrow up and down keys increment and decrement the value.

Up and down buttons auto-increment and decrement on touch hold if in mouse emulation mode. The change starts relatively slowly but accelerates until untouch. 

TOUCH DIALOG

The touch dialog is invoked by the touch tab (hot key T). All touch characteristics of the touchscreen can be modified through this dialog. If the system contains multiple touchscreens, the one being used to access the dialog should be selected in the device list box.

TOUCH MODE

The Touch Mode group enables selecting and testing the touch mode. This corresponds to the registry value "MouseMode". There are three possible touch modes, click on touch, click on untouch, and emulate mouse. In click on touch mode, touch generates left button down followed immediately by left button up; steam and untouch events are ignored. In click on untouch mode, touch and stream events are ignored; untouch generates left button down followed immediately by left button up. In mouse emulation mode, touch generates left button down; stream events generate mouse move; and untouch generates left button up. 

A large checkbox is provided for testing the touch mode. With click on touch, the check should toggle immediately upon touch. With click on untouch and mouse emulation, the check should toggle on untouch. 

Drag can be tested anywhere. With click on touch, the cursor appears at the touch point and does not move on drag. With click on untouch, the cursor does not move to the touch point and does not move on drag but does move to the untouch point. With mouse emulation, the cursor appears at the touch point and follows drag.

ANTI-BOUNCE

An untouch may occur inadvertently in certain situations, most notably when the finger or stylus momentarily loses contact with the screen while dragging. The driver can be configured to ignore such an event. Anti-bounce is the period of time (in msec) that an untouch must persist without a subsequent touch event for it to be recognized. At the minimum value of 0, no untouch is ignored. At the maximum of 775, any untouch followed by a touch within 775 msec will be ignored. Although this can make dragging easier, it has two undesirable side effects. One is that the response to untouch must be delayed by the anti-bounce time in all circumstances. The other is that a rapid touch-untouch may stick in the touched state. 

The dialog's Anti-bounce up/down control allows the time to be adjusted from 0 to 775 msec. Anti-bounce is active only under mouse emulation mode. The Touch Mode test checkbox can be useful for adjusting the anti-bounce time. If the anti-bounce time is too high, a quick touch/untouch of the checkbox will not cause the check to toggle.

TOUCH HOLD

DISTINGUISHING TOUCH HOLD

The most common user action with a touchscreen is a rapid touch/untouch. The user may also touch and drag or touch and hold without moving. All three actions are fundamentally the same sequence of events, a touch followed by some amount of movement and then untouch. To use touch hold as a distinct action, it must be distinguished from the other two types of touch. However, even the most rapid touch/untouch cannot be instantaneous and even a very steady user is likely to produce some touch movement while trying to hold in one place. Consequently, the distinction must be parametric. The amount of time without untouch after touch distinguishes touch hold from touch/untouch. The amount of movement ("jiggle") distinguishes touch hold from touch and drag.

ACTION

The touchscreen drivers can be configured to recognize touch hold and respond in three ways: to simulate a right mouse button click; to unlock a touchscreen from cleaning mode; or auto-untouch. Cleaning mode unlock is essentially right-click-on-hold under unique circumstances and uses all of the parameters of RCOH. Auto-untouch shares only the touch hold timer.

TIMER

One timer (per touchscreen device) provides the timing for all touch hold events. The period is set (in milliseconds) by the TouchTick up/down control. This is normally 100 msec. Higher resolution (smaller period) may be defined but will consume more CPU bandwidth. Bandwidth consumption can be reduced at the expense of resolution by defining a larger period. 

JIGGLE

The Jiggle up/down control sets the amount of touch position movement that will be tolerated. If the driver sees the position move beyond this range, it will interpret the action as touch and drag instead of touch hold. This is in normalized (to remove technology differences) touch screen position units, which are of higher resolution than most video screens. A typical value of 1024 provides a jiggle area of about 10 by 10 pixels on most screens. If touch hold seems to occasionally abort (as indicated by the feedback) prematurely, the cause may be jiggle set too low. 

AUTO-UNTOUCH

The Auto Untouch group comprises an enable checkbox and Ticks to Event up/down to define the number of ticks to wait before generating an untouch. This period is not from the time of the touch but from the time of the last stream touch. As long as the touchscreen continues to produce stream touch events, the auto-untouch does not trigger. This fulfills the purpose of quickly detecting cable disconnect or controller communication error without producing false untouches.

A procedure for testing auto-untouch is not obvious because its purpose is to recover from hardware failures. USB cable disconnect can't be used to test auto-untouch because the driver positively identifies that and immediately generates an untouch, bypassing the timed auto-untouch. However, serial cable disconnect can only be detected by the auto-untouch. To test this, it is best to disable RCOH to reduce display clutter. Set the auto-untouch to an abnormally long time, such as two seconds (e.g. 20 100-msec ticks). Set click on untouch or mouse emulation mode. Touch the Touch Mode test box and, without untouching, disconnect the serial touchscreen cable. In approximately two seconds, the check should toggle. 

In most cases, the auto-untouch timeout can be quite short because the facility does not simply count the time from the initial touch but is reset at every stream touch message. Thus, even a setting that detects cable disconnect within milliseconds allows unlimited touch time. This is especially useful for the 2500U and 3000U controllers, which occasionally lose an untouch message when the system is very busy. For these controllers, an untouch timeout of 300 msec prevents missing untouches without causing false untouches. The 2216 controller will cause false untouches with such a short timeout. Other controllers can operate with this timeout but they only need cable disconnect detection, which could be considerably longer. The circumstances of the application dictate the ideal range of timeouts but good starting points are 300 msec for the 2500 and 3000 controllers and one second for all others.

RIGHT CLICK ON HOLD

This group comprises two checkboxes and three up/down controls. The enable checkbox enables RCOH in general. The feedback checkbox enables the driver to indicate touch hold by an expanding reverse-video circle around the touch point. 

The Ticks to Event up/down sets the number of TouchTicks the driver counts before generating a right click mouse message.  

The Ticks to Show up/down sets the number of ticks the driver counts before displaying feedback. Setting this to 0 illustrates why this parameter is needed. Incessant feedback on every touch can be annoying. Any value larger than Ticks to Event disables visual feedback and the user will have no indication that a right click is imminent.

The Show Step up/down sets the visual feedback step size in display pixel units. At each TouchTick after Ticks to Show, the circle diameter increases by this number of pixels.

SOUND DIALOG

The sound dialog is invoked by the sound tab (hot key S). The sounds associated with touch down, touch up, simulated right click, and drag are selected through this dialog. If the system contains multiple touchscreens, the one being used to access the dialog should be selected in the device list box.

The sound dialog does not function under CE6.0. The sound characteristics can be configured but only by modifying the startup registry.

Touch sound characteristics apply to all touchscreens. It is not possible to assign unique sound schemes to different touchscreens. All of the sound parameters correspond to values under the registry key

[HKEY_LOCAL_MACHINE\HARDWARE\DEVICEMAP\TOUCH\SOUND]
SOUND HARDWARE

Sound can be associated independently with each of the four touch events. Drag can only be associated with the beeper, while the other three can be associated with either beeper or a wav file. Wav files play only if the system contains a sound facility that responds to CE's PlaySound function. Beeper sounds require a beeper facility that closely approximates the PC standard beep I/O interface and the EloBeep driver, which runs only on x86 systems.

All beep sounds are characterized by duration and tone. Drag sound duration is always infinite until untouch and, therefore, doesn't need to be specified. Tone is the period rather than frequency of the sound. It is the actual value programmed into the tone generator, which imitates an Intel 8254 PIT channel in square wave mode. CE does not include any component for controlling standard beep hardware. This is provided by EloBeep.dll.

DRIVER SOUND

Typically, the sound dialog is accessed via a touchscreen. Sounds already associated with the touchscreen can interfere with a sound being tested. To avoid confusion, it is best to turn off the existing driver sounds using the Driver sound on button. This is a push-like radio button. When it is depressed, driver sound is on. A sound scheme under development is not applied to the driver until the Driver sound apply button is pressed. The dialog contains a large checkbox touch test area for testing a sound scheme before applying it to the driver. However, even after applying the scheme, if Driver sound is off, the sounds will still occur only on touches in the test area. Testing touch, untouch, and right click sounds outside of this area would serve little purpose, but it can be informative to test drag sound across the entire display area. Driver sound must be turned back on to do this.

SOUND TEST

For all but drag sound, it is usually most productive to test a sound in isolation before testing it in the context of a touch event. The dialog's beep and wav radio buttons select either a beep or a wav sound to be tested. When beep is selected, the Tone and Duration up/downs configure the period (i.e. larger means lower frequency) and duration (in msec) of the beep. Pressing the Play sound once button plays the beep specified by these two parameters one time. Depressing the Play sound continuous button causes the beep to play repeatedly. This is useful for adjusting the tone but masks the duration characteristic.

When wav is selected, the file shown in the Wav File edit field is played once when the Play sound once button is pressed or continuously when the Play sound continuous button is depressed. Pressing the ellipses button opens a file open dialog to select a wav file. EloTalk exposes all wav files, even in directories where they are normally hidden. Most reside in \Windows.

TOUCH SOUND ASSIGNMENT

The dialog contains three identical touch sound assignment groups, "For touch down use", "For touch up use", and "For right click use". The currently selected (by beep or wav radio button) sound can be attached to touch, untouch, and/or right click by pressing this sound button in one of the three groups. The same sound may be attached to more than one event but this rarely provides a good user experience. In addition, because most wav sounds are of relatively long duration, during which the user interface is inactive, wav sounds are typically more effective for right click than for touch and untouch.

Pressing the silent button removes the sound assignment from an event. Pressing the ? button restores the configuration of the sound assigned to the event. For example, if the sound currently under development is a wav but touch is assigned a beep sound, pressing the ? button in the touch down group changes the current sound from wav to beep with the tone and duration of the assigned sound.

Touch sound assignments can be tested in the touch test area. They become permanent only when the apply button is pressed. Closing the dialog without doing this loses the information.

DRAG SOUND

Drag sound is generated by the beep hardware but is uniquely configured by Start, Step, and Post up/down controls. Drag sound cannot be tested independently of the drag event because the drag itself determines the tone. When enabled, the drag sound begins when the touch moves some distance from the touch down point. Touch hold produces no drag sound. The tone (frequency) of the drag sound is initially relatively low and rises as the touch moves away from the initial touch point. The tone depends only on distance from the initial touch point. 

Start sets the initial tone. Step defines how rapidly the tone changes relative to drag distance from the touch down point. Smaller values cause the tone to change more slowly. The exact numeric effect of step varies with touch screen and video resolution but 

the usable values normally range from 10 to 500, with 100 typically providing a good response. Post defines how far the drag must move (in touch grid points) before the tone changes. For example, if Post is 20, the sound does not begin until the drag point moves at least 20 grid points from the touch down point and the sound changes only at each additional move of 20 grid points or more. In effect, Step corresponds to frequency acceleration while Post corresponds to resolution. A fourth parameter, which sets an upper frequency (lowest period) boundary, can be controlled though the registry but not in the sound dialog.

The drag tone checkbox allows the tone to be turned off without changing the parameters. As with the other touch event sound assignments, drag sound can be tested in the touch test area. They become permanent only when the apply button is pressed. Closing the dialog without doing this loses the information.

CALIBRATION DIALOG

MAIN DIALOG

The main calibration dialog, which is invoked by the calib tab (hot key C) comprises three groups of functions. One function, invoked by the calibrate button, is simply to invoke Elova, the calibration program. This is provided for convenience. Some calibration options modify Elova's behavior and/or require recalibration. When Elova closes, control returns to this dialog. A second function, invoked by the test button, opens the calibration test window, a complex and largely self-contained facility. The third function group comprises configuration controls in the dialog itself.

Do Edge Calibration On

The "Do Edge Calibration On" control comprises four checkboxes, left, top, right, and bottom. When linearity correction is enabled for a touchscreen, Elova first presents a standard three-point calibration to the user and then an option to perform edge calibration. Even if the user elects to do this, edge calibration may not be needed for all edges. To simplify calibration, only the selected edges are presented. The edges not presented either use unadjustable parameters from the registry or no linearity correction.

The edges presented for calibration are indicated by the registry value "EdgeCalCfg" for each touchscreen in the system. Bits 0 through 3 tell whether to present left, top, right, or bottom edges, respectively. The calibration dialog shows the current data value of EdgeCalCfg in a read-only field.

3-Point Calibration Parameters

Some touchscreens can store three-point calibration parameters in the screen controller, eliminating the need for CE registry persistence and allowing touchscreens to be pre-calibrated. When the CE system starts, the touchscreen drivers read each touchscreen's calibration parameters from either the registry or the touchscreen. The radio button group "Read: touchscreen, registry, none" select this source. If "none" is selected, the driver uses hard-wired default values until the touchscreen is calibrated. This option is only used for testing. The driver uses these initial values unless the touchscreen is recalibrated.

When calibration is performed (elova) and the results accepted by the user, the parameters are written to the touchscreen and/or the registry. Unlike reading, for which there can be only one source, the parameters may be written to multiple destinations. Although it might seem superfluous to write to a destination that will not subsequently be used as a source, it may be useful to write to the registry even when the touchscreen is the read source because applications can inspect the registry and may find some value in monitoring calibration changes. The write destinations are selected by checkboxes "touchscreen" and "registry". If neither is checked, the parameters are not written but only used by the driver until the system reboots.

For each touchscreen, the read source and write destination are indicated by the registry value "CalStore", where the low nibble of the lowest byte identifies source and the high nibble of this byte identifies the destination. For both, the value 1 indicates touchscreen (controller), 2 registry, and 3 both. The calibration dialog shows the current data value of CalStore in a read-only field.

Not all controllers support calibration data storage. The controllers that do provide this are 2216, 2500, 2700, 2701, 4000, 4500, 4501, and 5000. Controllers that afford both serial and USB interfaces support this identically on either interface but some, such as 4500, require different calibration data for serial vs. USB. These must be calibrated through the same interface through which they are used (the system need not be the same, however).

Flush Registry Calibration Writes

Edge calibration parameters, which are essential to linearity correction, can only be stored in the registry. Three-point calibration parameters may be stored in the registry. Values stored in the registry at run time are permanent only if the registry is persistent. Many CE systems do not support registry persistence. For some that do, data written to the registry is not committed unless the registry key is flushed by calling the OS platform function RegFlushKey. 

Touchscreen drivers, rather than Elova, perform both reading and writing of calibration parameters. When they write these to the registry (always for edge and if directed by CalStore for three-point) they will call RegFlushKey if CalStore bit 9 is set. Thus, CalStore for each touchscreen tells source and destination for three-point parameters and whether to call RegFlushKey for both three-point and edge parameters. The current value shown in the dialog for CalStore reflects this.

ACCELERATION AND LINEARITY CORRECTION

The primary purpose of the calibration test facility, accessed by the calibration dialog's test button, is to test complex calibration configurations. To fully appreciate this it is necessary to understand acceleration and linearity correction.

Finger access to positions near the edges of a touchscreen, for example to activate standard window close and system tray icon buttons, can be inconvenient because the cursor normally tracks the center of touch and the bezel blocks the required finger movement. This problem may be aggravated by non-linearities in a resistive touchscreen, which may be more severe near the edges. 

The problem can be reduced or eliminated by acceleration and/or linear correction. The touchscreen driver (eloSer.dll or eloUsb.dll) produces "edge acceleration" by reporting mouse positions that shift toward a screen edge as the touchpoint moves toward that edge. Edge acceleration distorts the video-touchscreen relationship and can even cause some positions away from the edge to become inaccessible. Consequently, acceleration should be as little as necessary to afford edge access. Non-linearities in the touchscreen exacerbate this tradeoff because a response trough near an edge requires additional acceleration while a peak further from the edge requires less than average. Therefore, correcting non-linearity, especially near edges, improves acceleration.

In some applications, unaccelerated edge access is acceptable except in the corners of the screen. For these, accelerating just the corners avoids the broader distortion of accelerating entire edges. Corner acceleration simply defines an area within which any touch position is translated to a specified screen position.

The touchscreen drivers support all three means of improving edge access-- linearity correction, edge acceleration, and corner acceleration. Each edge may independently receive simple edge acceleration or linearity correction, which includes its own form of edge acceleration. Each corner can be accelerated independently of the treatment of edges or other corners. Simple acceleration and linearity correction can't be combined on one edge and corner acceleration is not usually of any value with linearity correction. However, corner acceleration combined with edge acceleration may allow the edge acceleration rate to be reduced. 

All acceleration and linearity correction data are stored in the registry, even if three-point calibration data are stored in the touchscreen. Edge and corner acceleration parameters can be determined once for a product and stored in the OEM registry image. Linearity correction data is produced by performing an edge calibration, which may have to be repeated in the field. Without registry persistence, edge calibration may have to be repeated every time the product is turned on. 

Elova provides both standard three-point and edge calibration. When invoked, Elova always presents the three-point calibration and then displays a dialog for the user to accept or repeat the calibration, to quit, or to perform edge calibration. Edge calibration data is used only for linearity correction, which the driver performs before touch-to-mouse translation. Consequently, it is insensitive to changes in the touchscreen-video relationship and does not need to be adjusted as often as the three-point calibration data. 

For three-point calibration, Elova presents three points in succession, expecting the user to touch each one exactly. For edge calibration, the user slides their finger along an edge using the bezel for a guide. A series of dots is presented along the edge to tell the user approximately where to touch. Dots disappear as the user touches near them. Remaining dots indicate areas that do not yet have sufficient data, due either to the user skipping them or extreme linearity distortion. Corner dots may remain due to access restrictions of the bezel. The user should be instructed to simply keep pressing the remaining dots in the way the touchscreen is normally used. Elova recognizes when the user is trying repeatedly to touch the same dot, even if not very close to it, and continually expands the range that it will accept so that all dots will eventually be gone.

Elova presents for calibration only the edges configured for linearity correction. For example, if linearity correction is enabled only for the top, when the user selects edge calibration Elova displays the dots on the top edge and redisplays the accept dialog as soon as the user finishes that edge. If no edges are configured for linearity correction, the edge calibration button is disabled. 

Except for calibrating edges that have already been selected, the end user has no options regarding acceleration and linearity correction. Configuration information resides in the OEM registry image. 

CALIBRATION TEST

Although the system developer could configure the system just by editing the reg files that are incorporated into the image, it could be difficult to predict the optimum configuration. The calibration test facility allows interactive configuration, parameter adjustment, and testing of all options. 

The calibration test facility comprises a test window, which occupies the entire screen, and a configuration dialog, which can be moved around over the test window. The test window contains a grid to assist visualizing the effect of a particular configuration especially when the show trails checkbox is checked. Briefly, the dialog's controls act as follows.

1. Trails

1.1. show. When check leaves a trail, in the selected color, behind touches.

1.2. clear. Erases touch trails.

1.3. color. Selects the trail color. Clicking this cycles through the range of colors. 

2. Test Pad Size

2.1. Up/down numeric tells the pixel resolution of the grid. 4 is the smallest grid resolution. Selecting 3 changes the test window to a plain gray and touches to the equivalent of a pen.

2.2. min selects the smallest grid resolution (4)

2.3. icon selects a grid resolution matching the size of standard window title bar buttons (at the current video resolution).

3. Edge Acceleration

3.1. left, top, right, bottom checkboxes enable standard edge acceleration for edges that have not be configured for linearity correction. When linearity correction is selected for an edge, the corresponding checkbox is checked but disabled, indicating that acceleration is always part of linearity correction.

3.2. Rate up/down controls set the acceleration rate for each edge. These are active for both standard edge acceleration and linearity correction but the ranges are different. For standard edge acceleration the value does not directly correspond to an obvious physical quantity but arbitrarily ranges from 2 to 100. For the acceleration component of linearity correction, the rate corresponds to an offset, in touchscreen points, determined during edge calibration. The rate can only be reduced from this experimentally determined value. 

3.3. Border up/down controls set the edge acceleration border. Only touchpoints outside this border are accelerated. The border currently does not work with linearity correction, for which acceleration increases continuously from the center of the screen to the edges. 

3.4. show border checkbox causes the edge acceleration border to be show.

3.5. <> unlabeled buttons uniformly reduce or increase the size of the acceleration border.

3.6. min and max set the border to its minimum (which may cause it to be hidden under the floating dialog) or maximum recommended size. The border may be explicitly made smaller or larger than these recommended limits.

4. Linearity Correction

4.1. left, top, right, bottom checkboxes enable each edge to be independently selected for linearity correction.

4.2. all and none select linearity correction for all edges at once.

5. Corner Acceleration

5.1. Each of the four upDown controls sets the width and height of the "capture" area around the corresponding corner. A touch in this area produces a mouse event at the screen position specified by the Edge Target.

5.2. on checkbox turns all corner acceleration on or off at once.

6. Edge Target. This up/down control sets the ideal position of a mouse event near an edge or corner in terms of touchscreen points offset from the edge (or edges in a corner). It is shared by edge calibration and corner acceleration and, although the two use it differently, it has the same meaning for both. During edge calibration, Elova uses it to determine the ideal position of touches relative to the edge and, by inference, the edge acceleration irrespective of linearity correction. For corner acceleration, the driver generates a mouse event at this offset from the corner for all touches in the "capture" area. The default is half the width of a small icon. A value of 0 causes linearity correction and corner acceleration to accelerate touches to the furthest edges of the screen.

CALIBRATION TUTORIAL

OVERVIEW

Touchscreen drivers translate position information in the touchscreen domain to system video domain mouse events. Translation based only on three-point calibration results is simple for the driver and relatively easy to understand but may not yield a good user experience with some touchscreens. Two unaddressed problems are the difficulty of touching near the video edge and non-linearity in the touchscreen's touch position response. 

All touchscreens require three-point calibration parameters. Some may work better with the addition of edge acceleration and/or linearity correction. Unlike three-point parameters, which apply to the entire screen, edge acceleration and linearity correction are edge-specific and may not be required for all edges. Unnecessarily accelerating an edge adds slightly to the driver's work but is otherwise meaningless. Unnecessarily including linearity correction for an edge adds useless work for the end user.

Many factors determine the ideal combination of configuration and parameters for a given touchscreen application. Some of these can be predicted based on the touchscreen type while others are determined by the application and/or video-touchscreen physical relationship. EloTalk's calibration facility enables rapid configuration and testing to determine the best configuration interactively. System developers use this facility to optimize a first article and then transfer the resulting touchscreen registry settings to OS design source files. The configuration keys must be included in the design but, normally, the parameter keys, most of which the end-user can change by executing Elova, are also included to provide a functional initial condition for the system.

TEST SYSTEM

Elotalk's calibration facility is intended for use in the target system but this tutorial may be run on any system that has an Elo touchscreen. With Elo's bootable CE disc, a standard PC can serve as the test system. Different kinds of touchscreens exhibit significant calibration differences. For example, linearity correction is relevant only to resistive and capacitive touchscreens. Performing the tutorial section on linearity correction with Intellitouch or IR screens could lead to the erroneous conclusion that linearity correction serves no purpose. Similarly, edge acceleration is not relevant to IR.

This tutorial describes most button activation as "click", suggesting that a mouse is being used. In most cases, touch can also be used except where the touchscreen is deliberately mis-calibrated. Some button functions can also be activated by hot key if the system has a keyboard.

MAIN DIALOG

Start EloTalk. Click on the calib tab or press the C key. 

Calibrate

Click the calibrate button. Elova should appear and present the first of three targets. Press the Esc key to return to EloTalk. 

Esc aborts calibration at any time, restoring the previous calibration. If the touchscreen is adequately calibrated, invoke Elova again and touch random points far from the targets. Touch and/or slide your finger in Elova's window to see the resulting bad calibration. Press the Esc key to abort Elova and return to EloTalk. Note touch operation.

Do Edge Calibration On

Clear the left, top, right, and bottom checkboxes in the Do Edge Calibration On group. Click the calibrate button. Touch Elova's three targets. Examine the accept dialog. It contains three active buttons, Accept, Redo, and Quit, and one disabled button, Calibrate Edges. Click Quit or press the hot key Q to return to EloTalk.

Click the "top" checkbox in the Do Edge Calibration On group. Click the calibrate button. Touch Elova's three targets. The Calibrate Edges button is now active. Click Quit or press the Q key to return to EloTalk. The user decides whether to do edge calibration but only if the configuration (as defined by the registry value "EdgeCalCfg") declares at least one edge.

Click the calibrate button again. After touching all of Elova's three-point targets, touch the Calibrate Edges button. A row of small gray targets appears along the top edge of the screen. Touch the upper left corner of the screen as near to the corner-most target as the bezel allows without distorting your finger. Using the bezel as a guide, slide your finger to the upper right corner. Notice that the targets disappear as your finger comes near them even if blocked by the bezel. Touch any remaining targets, repeatedly if necessary, until they have all disappeared. Again, don't distort your finger, even in the corners. When only a few targets remain, Elova expands the reach of a target after each failed attempt to touch it. When the last target disappears, the accept dialog reappears. Click Quit or press Q to return to EloTalk.

Clear the top and bottom and check the left and right checkboxes in the Do Edge Calibration On group. Click the calibrate button. Touch Elova's three targets. Click the calibrate edges button. Calibrate the right edge. Calibrate the left edge or skip this by pressing the Esc key to abort Elova and return to EloTalk.

EdgeCalCfg

Clear all Do Edge Calibration On checkboxes. Observe that EdgeCalCfg is 0. Check left, top, right, and bottom in succession. Note change of EdgeCalCfg from 0 to x1, x3, x7, and xF. 

CalStore

In the 3-Point Calibration Parameters group, select Read touchscreen, check Write touchscreen and uncheck Write registry. Uncheck "flush registry calibration writes". Note CalStore is x11. Check "flush registry calibration writes". CalStore is now x111. Check Write registry and see CalStore change to x131. Select Read none. CalStore changes to x130. Only one (or none) three-point calibration source is allowed but calibration results (parameters) may be written to both the registry and the touchscreen controller. Edge calibration results are always read from and written to the registry.

CALIBRATION TEST

Calibration test is most intuitive with mouse emulation touch mode. If this is not already the case, click EloTalk's touch tab to open the touch dialog. Click Touch Mode "mouse emulation". Return to the calibration main dialog and click the "test" button.

Calibration test comprises a full-screen grid for testing configurations and parameters plus a dialog that floats over this for setting edge and corner acceleration and linearity correction and for configuring the test grid. Nearly all selections from this dialog take effect immediately and are evidenced by touching in the test grid. 

The ultimate test of a particular configuration is how well it works in the intended application. However, it can be difficult to perceive the effect of a particular change without going through a time-consuming test of the entire application. For example, corner access problems cause by non-linearity are easily overlooked if the test application doesn't include a small target (such as a close button) in that corner. 

The purpose of the test grid is to interactively demonstrate the effect of a configuration change quickly and without complex planning. For example, if a touchscreen has significant scalloping on an edge due to non-linearity, the improvement made by linearity correction can be immediately demonstrated by sliding a finger along that edge (using one trail color) first without compensation and then (in a different color) with compensation turned on.

Trails

Check show. Touch and/or slide in the grid to see a touch trail in the current color, which is initially gray.

Click on the colored pad in the Trails group. It changes color (from gray to red). Touch the grid to see this color used for the touch trail. Click the color pad again to change red to blue and again to change blue to cyan and again to return to gray.

Click the clear button to clear the trails. Throughout this tutorial, clear the trails between tests.

Test Pad Size

The default grid resolution is automatically selected to match the size of a "small icon", which is the size that the OS uses for title bar buttons (close, minimize, maximize). 

Click the min button to redraw the grid at the minimum resolution of 4 pixels. With trails turned on, slide your finger in the grid and/or touch specific pads.

Click on the icon button to redraw the grid at the "small icon" resolution and touch some grid pads.

Touch and hold the size Up/Down '<' button. The grid size steps down to 3. At this size, the grid disappears and the touch area becomes a simple painting program with your finger producing a one-pixel free-form line. Using one bezel edge for a guide, slide your finger back and forth several times along the edge, producing an average response line. This can be useful in minimizing "outliers" due to unsteady hand movement.

Keeping the test pad size 3 (gridless) click the Trails color button several times to cycle through the colors. These are only black, red, and blue and the selection is independent of the color selected for gridded operation. 

Touch the size Up/Down '>' button to change from gridless to minimum grid resolution.

Edge Acceleration

Edge acceleration is appropriate for any type of touchscreen except IR. Before starting the Edge Acceleration tutorial, perform a three-point calibration (click "Accept" in Elova's accept dialog) and return to EloTalk's calibration test window. Set the test pad size to min. Check Trails "show". Select gray Trails color. Click the Linearity Correction "none" button. Uncheck Corner Acceleration "on". Uncheck left, top, right, and bottom checkboxes in the Edge Acceleration group.

Move the Calibration Test dialog into the lower right corner of the screen. Only the Edge Acceleration group needs to be exposed. 

In the Edge Acceleration group, check show border and click min and then max. Observe the border. Points outside this are accelerated toward the edge. Points inside the border are not accelerated. After clicking max, click the '>' button to the left of "min" several times. Observe all edges of the border expanding outward. Click min and then click the '<' button to the right of "show border" several times. Observe the border shrinking. The "min" and "max" buttons set the border to reasonable minimum and maximum size. You can shrink it to less than "min" and greater than "max" but such settings will not produce the best results. 

Click the max button. Click and hold the Border left '>' button. Observe the left edge of the border moving rightward (increasing X position) while the other borders don't change. Click and hold the Border top '>' button and observe the top edge moving downward independently of the other edges. Click and hold the Border right '<' button and observe the right edge moving leftward. Click and hold the Border bottom '<' button and observe the bottom edge moving upward. 

Using the Border '<' and '>' buttons, adjust all edge to approximately 25% of the screen dimension. This is a good setting for observing the effect of acceleration but is atypical. In most cases, the max setting works best. 

Set the Rate for each edge to 20. This is done through the Rate left, top, right, and bottom up/down controls either by clicking the '<' and '>' buttons or by typing a number in the edit field and pressing Enter. Try both methods if your system has a keyboard.

Check Edge Acceleration left, top, right, and bottom checkboxes. Using a stylus (for best visibility) or your finger, touch down inside the border and slide toward any screen edge. Observe that the highlighted grid pad is directly under the stylus inside the border and starts "accelerating" toward the screen edge as soon as the touch point moves beyond the border. The further the touchpoint moves away from the border, the greater the offset of the response toward the screen edge.

The acceleration "rate" is a dimensionless value between 2 (least acceleration) and 100. Change the Rate left to 2 and top to 100. Observe the touch response on these two edges. The left acceleration is so slight that it may appear to not exist at all. Slide your finger or stylus along the left edge using the bezel for a guide. Click the Trails color pad. Uncheck the Edge Acceleration left checkbox. Repeat the drag touch. The new color shows the response with no edge acceleration at all. Click the left checkbox to restore left edge acceleration.

At these settings, the top edge acceleration is so severe that it interferes with the test of left edge acceleration. This is due to the combination of its Rate and Border settings. The same rate has a much less pronounced effect when the border is closer to the edge. Click the Edge Acceleration "max" button. Repeat the left edge drag touch, observing how much the effect of top acceleration is reduced by the border change.

Check Trails "show". Click Test Pad Size "min". Click Edge Acceleration Border "max". Check Edge Acceleration left, top, right, and bottom. Set each Edge Acceleration Rate to 20. Slide your finger along each edge using the bezel for a guide. If necessary, adjust each Edge Acceleration Rate until your drag touch produces a trail that includes only pads in the first three grid rows from the edge and most pads in the second row. If your screen has unusually good linearity, you may be able to place the entire trail in the second row. This is the ideal Edge Acceleration Rate (for this Acceleration Border).

Click Test Pad Size "icon". Slide your finger along each edge. Observe that, at this pad size, the pad trail encompasses only the first row along each edge. Since this pad size matches the size of the "small icons" used for title buttons, a user will be able to touch a window's control buttons at any screen position. All buttons in the system tray can also be touched.

Click the Trails color. Try to touch (by drag or discrete touches) every pad in the second grid row from each edge. If the screen has good linearity, each pad responds to its apparent position. Otherwise, touching the middle of some pads changes the color of the pad in an adjacent row, indicating too much (row 1) or too little (row3) acceleration. 

Click Test Pad Size "min". Increase each Edge Acceleration Rate until the pad trail encompasses only the first grid row along the edge. All pads can be touched, even though some must be accelerated beyond the edge, because the driver enforces an edge limit. Click Test Pad Size "icon". Touch the middle of each pad in the second row from each edge. Many of the first row pads respond because the acceleration rate is too high. 

If you find it impossible to set the acceleration rate of an edge such that you can touch all first and second row "icon" pads reasonably comfortably, test the effect of moving the border. Any part of an edge trail that lies inside the acceleration border is not accelerated. This can only be corrected by moving the border toward the center of the screen (and decreasing the acceleration rate).

If your touchscreen has poor linearity, you may find that no combination of border and rate yields good results and linearity correction will be required.

Linearity Correction

In the Calibration Test dialog, click TestPad Size "icon". Set Edge Target value to the displayed Test Pad Size divided by two. Typically, the small icon size is 16 (pixels) and Edge Target is assigned 8. This is not the data assigned to registry value "EdgeTarget", which is in touchscreen point units. EloTalk translates the video pixel value to touchscreen units.

Check Trails "show"; click Test Pad Size "min"; click Linearity Correction "none"; uncheck all Edge Acceleration edges and "show border"; uncheck Corner Acceleration "on". Using the bezel for a guide, slide your finger along each edge. If the trails are essentially straight, your touchscreen does not need linearity correction. You may still use it for this tutorial but the purpose of linearity correction will not be evident. 

Note which edge exhibits the most non-linearity. Close the Calibration Test window. In the Do Edge Calibration On group (calibration main dialog) check only this edge. Click the "calibrate" button, invoking Elova. After performing the three-point calibration, click the Calibrate Edges button (or press the E key). Calibrate the edge as explained in the "Do Edge Calibration On" tutorial. Click Accept or press the A key in Elova's accept dialog to return to EloTalk's calibration main dialog. Click "test" to reopen the Calibration Test window. Slide your finger along the chosen edge. Click the Trails color box. Check the Linearity Correction checkbox for the chosen edge. Slide your finger again along this edge. Except for corner effects due to the adjacent edges not being corrected, the two trails show the extent to which correction can improve the touchscreen's accuracy.

Note that the Edge Acceleration checkbox corresponding to the edge you selected for linearity correction is both checked and disabled. Uncheck the Linearity Correction checkbox for this edge and then check it again. The Edge Acceleration checkbox state reflects that linearity correction inherently includes edge acceleration. You cannot turn this off. When Linearity Correction is enabled for an edge, its acceleration border and rate can be adjusted but this is a complex topic not addressed in this tutorial. Acceleration can also be adjusted, in effect, by changing the value of Edge Target. This is the offset (in pixels in this dialog but in touchscreen units in the registry) from the edge considered ideal for edge targets. Changing it in the Calibration Test dialog does not immediately affect touch response because it is used by Elova during edge calibration rather than by the driver during event translation.

Set the value of Edge Target to 1. Close the Calibration Test window. In the main calibration dialog, click "calibrate". Perform the three-point and edge calibrations and accept the result. Back in EloTalk's main calibration dialog, click "test". In the Calibration Test window slide your finger along the edge selected for linearity correction. Note that most, if not all, of the trail pads lie in the first row from the edge. Repeat this process with an Edge Target value equal to the "icon" pad size (i.e. twice as large as the initial value).

Change the Edge Target value back to its initial half-icon size. Close the Calibration Test window. In the main calibration dialog check all four edges in "Do Calibration On". Click "calibrate". In Elova do the three-point calibration and all four edges. Accept the result, returning to EloTalk's main calibration dialog and click "test". In the Calibration Test window, click the Linearity Correction "all" button. Slide your finger against the bezel on all four edges. Click the Trails color. Click the Linearity Correction "none" button. Slide along all four edges again to produce uncorrected trails for comparing to the corrected ones.

With all Linearity Correction edges unchecked, try touching various points near edges and closer toward the center of the screen, noting response error. Click Linearity Correction "all" and try touching in the same areas for comparison. Click Test Pad Size "icon" and repeat this random point response test with all edges corrected and with none corrected.

Recalibrate the screen but perform only the three-point procedure and then choose Accept. Return to the Calibration Test window. Click Test Pad Size "min" and Linearity Correction "all". Slide your finger along all edges. If the user decides not to perform edge calibration, the existing parameters are retained and will continue to work correctly. 

Corner Acceleration

In the Calibration Test dialog, set Edge Target value to the Test Pad Size "icon" divided by two. Click Linearity Correction "none" button. Uncheck all Edge Acceleration edges and "show border". Click Tails "show". Click Test Pad Size "min". Set all four edit fields in the Corner Acceleration group to 40 and check "on".  Using the bezel as a guide, slide your finger along all four edges. The trails should show a large gap around each corner with a single colored pad in the corner. Corner acceleration doesn't work with certain touchscreens. If you don't see this result, you have one of the touchscreens that does not support corner acceleration.

The up/down fields in the Corner Acceleration group represent the capture area of the left-top, left-bottom, right-top, and right-bottom corners. The numeric value indicates the size of the area in touchscreen units. Any touch within a corner's capture area is accelerated to a point defined by Edge Target. Change the left-top area to 20, clear the trails, and slide your finger along the left and top edges near the left-top corner to see the effect of a smaller capture area.

Corner Acceleration and edge calibration share the Edge Target because it has the same meaning in both situations. It is the ideal edge point offset; and half the width of a small icon is typically ideal. However, you can make this smaller to increase acceleration toward the edge or larger to decrease acceleration. Change Edge Target to 1, clear the trails, and slide your finger along all edges near the corners. Repeat this with Edge Target equal to twice its initial value (e.g. 16). At this setting you may find that the left-top corner touch point is actually offset toward the middle of the screen instead of being accelerated toward the edge. 

Corner Acceleration can be combined with Edge Acceleration to accommodate a touchscreen that has a significant response droop (due to non-linearity) in a corner or an application that works well with its touchscreen except that one or more corners contain an important point that is difficult to touch, for example a window's title bar close button.

SMARTSET DIALOG

The SmartSet dialog is invoked by the smartSet tab (hot key M). Through it, direct communication with a touchscreen controller is possible. Communication with only one controller at a time is possible. If the system contains one touchscreen, it will automatically be selected. Otherwise, communication occurs only with the device selected in the device list box. 

This dialog is used for diagnostic and touchscreen configuration operations. By confirming controller communication, it can reveal whether an apparently dysfunctional touchscreen is unable to communicate at all or is not producing appropriate touch events. The dialog can be used to read and write the touchscreen's serial number; to test its non-volatile memory (used for storing calibration data); to inspect the controller's configuration; and to read and write the controller's operating mode.

SMARTSET PROTOCOL

All communication with Elo touchscreens occurs via the SmartSet protocol. Touchscreens use one type of SmartSet message to report touch events. The drivers always translate and report these as mouse events. There are many more types of messages, serving different purposes. During normal operation, neither the driver nor the touchscreen generate any of these others. However, during startup and calibration, the driver may send or retrieve calibration parameters from a touchscreen, utilizing some of these other message types.

EloTalk's smartSet dialog supports a subset of the complete SmartSet protocol. The touchscreen controller does not initiate any communication with the dialog. Every transaction is initiated either automatically by EloTalk or by activating a control in the dialog.

TRACE WINDOW

The trace window shows all SmartSet transactions in binary and ASCII. SmartSet packets are short and the trace display further reduces them by showing only the payload. Each trace line shows the payload of one packet. Each begins with either H>D, indicating message transmission from host (CE system) to device (touchscreen), or H<D, indicating transmission from device to host. All transactions begin with one H>D message. This is followed by at least one H<D reply and, possibly, additional replies depending on the content of the H>D message. 

The trace shows the hexadecimal value of each byte of the payload. It also shows the payload as ASCII characters. The unprintable value 0 is shown as '$'. Other unprintable values are shown as a box (or other graphic symbol). The SmartSet payload contains a mixture of binary and ASCII values and that not all are printable is not significant.

ID QUERY

When the dialog opens, it sends an ID inquiry to every registered touchscreen. The response, if any, tells the type of controller in the touchscreen. From these responses, the device selection list is created. The inquiry is an 'i' message and the response is an 'I' message. The trace may also show one or more ack transactions ('a' inquiry followed by 'A' response). These are inserted for certain controller types. 

If a queried device doesn't respond, the trace shows the 'i' message but no response. In most cases, an error message box also pops up announcing a communication error. The dialog only queries devices that could reasonably be expected to exist, that is serial devices listed in the registry and any USB devices that have attached (whether listed in the registry or not). Unattached serial devices, USB devices that have attached but subsequently detached, and failed devices are most likely to be non-responders. The device selection box shows non-responders with as much information as is known, for example "Elo1: Serial Unknown".

The opening trace, without further investigation, tells a lot about touchscreen status. Any touchscreen that responds to the ID inquiry is able to communicate and is properly incorporated into the OS image. If it does not appear to be producing touch events, the problem lies either in the actual touch mechanism (i.e. a broken screen) or in configuration, most likely calibration. If the touchscreen does not seem to retain calibration, as requested by registry value "CalStore", the device selection list may reveal that the controller is not one of the types that support this function.

MODE

Elo touchscreen controllers can be programmed to translate touch input in a variety of ways. Some of these are intended for use with non-Elo and obsolete Elo drivers. It is essential that the mode be compatible with new drivers. If the ID query receives a reasonable reponse, yet the touchscreen still does not calibrate correctly, its mode may be improperly configured. 

The mode comprises two bytes. In the smartSet dialog, the two edit fields after the get mode button show these as hexadecimal values when the button is pressed. The first byte (mode1) should be x87 or x07. This indicates that the controller sends touch messages on touch down, stream (hold) touch, and touch release. The second byte (mode2) should be x00. This indicates that the controller sends raw coordinate information instead of applying its own calibration and scaling formula. 

The drivers try to force a controller's mode to x8700 during initialization. If a mode query (get mode) doesn't show x8700 or x0700, the touchscreen controller may be malfunctioning. If mode1 is x85 or x05, the touchscreen may still operate but no touch-hold functions, including right-click and missing untouch detect, will function. 

SERIAL NUMBER

All Elo touchscreen controllers support a six-character serial number. Some newer controllers also support a page-mode serial number comprising four five-character fields. The smartSet dialog can read either type but can write only the single-field type. In the Serial Number group, two radio buttons, 1 and 4, select the type.

EloUsb for CE distinguishes touchscreens by their order of attachment, ignoring their serial numbers. Consequently, touchscreens in a multi-screen system do not require unique serial numbers.

CALIBRATION AND SCALING

The Calibration and Scaling group reads and writes the controller's working parameters. Due to dialog size limitations, only one axis, selected by radio buttons X, Y, Z, can be accessed at a time. Values are shown in decimal or hexadecimal, selected by radio buttons dec, hex. The same data can be interpreted in two different ways, as low and high range or offset, numerator, denominator. Both interpretations are shown when reading. To write, either the set range or set OND button is pressed, avoiding the ambiguity that would arise from incompatible values being typed into the range vs. OND fields.

QUERIES

The Queries group contains buttons to send configuration information requests to the controller. The controller's responses are displayed only in the trace window in the form of messages, whose meaning requires interpretation according to the SmartSet protocol. Ack simply asks the controller to ack back. ID asks the controller to identify its type. Config asks the controller to send essentially everything that it knows about itself. Cal asks for the working calibration values of all three axes, X, Y, and Z. In contrast, Calibration and Scaling interprets the parameters and supports changing them but operates on only one axis at a time.

NVRAM

Most of the touchscreen controllers contain non-volatile RAM that can be read and written, but only indirectly. NVRAM is divided into setup, calibration, and scaling areas, which may be "read" into the controller's working parameters or "written" from the working parameters. Additionally, some of the controllers contain two pages of NVRAM, which are identical in form but can store different values.

The dialog's NvRam group contains controls to effect NVRAM transfers. It does not provide the means to read or write data directly to NVRAM. To read NVRAM data, the desired data block is first transferred from NVRAM to working parameters by pressing the read button after setting the Area and Page. Then Calibration and Scaling or Queries functions are used to read and display the data. Setup data cannot be written. To write calibration or scaling data, Calibration and Scaling functions are first used to write the working parameters. Then the NvRam write function is used to transfer the data to NVRAM.

SYSTEM DIALOG

The System dialog is invoked by the system tab (hot key Y). It primarily supports general test and development functions, most of which apply to all touchscreens in the system. It also supports miscellaneous functions that don't belong in other dialogs.

REGISTRY

The registry is used to store touchscreen configuration and calibration data. Certain key values are required for the operating system to load the drivers at all. These must be present in the CE image. Other key values, which enhance touchscreen operation but are not essential, may be created by the drivers and support programs, such as eloTalk. However, end users are usually not allowed to significantly reconfigure the CE device. To derive the most benefit from driver flexibility, it is necessary to build the image with much or all of the touchscreen configuration information already in the registry. It can also be helpful to embed functional, even if not perfect, initial calibration data in the registry. 

As described in Appendix B, to address all touchscreen configuration options, many registry values are needed. In some cases, the data comprises complex bit-fields rather than a simple enumeration. Appendix B and other documents fully explain the registry usage but it can be tedious to calculate the exact values and data required to achieve a particular configuration. Computing three-point calibration parameters by hand is very difficult. Computing edge calibration data by hand is impossible.

Through EloTalk, virtually all aspects of touchscreen operation can be configured without any knowledge of registry usage. Using EloVa, touchscreens representative of the ones that will be in production can be calibrated. If the resulting touchscreen registry settings were copied and pasted into the reg files used to make the CE image, a precisely configured and functional system could be produced with relatively little effort.

SAVE REGISTRY

The system dialog's "save registry" button produces a text file containing all current registry settings related to touchscreens. This is organized and formatted in the same manner as source reg files (eloUsb.reg, eloSer.reg, eloVa.reg) so that large portions of it can be copied into the sources. In fact, the entire file could be used without modification in place of individual source files. The file is saved as eloreg.txt in the CE system's windows directory. If the CE system has general network or web access, the file can be transferred by ftp or email (attached or pasted). If it is connected by serial or Ethernet to a development computer, the file can be transferred using Platform Builder's Tools > Remote File Viewer > Import function (tool bar down arrow icon).

VIEW REGISTRY

If the CE device has no means of sending the eloreg.txt file, it is still possible to examine the registry values related to touchscreen operation. The "view registry" button opens a large text window and displays the same content as eloreg.txt. This could also be useful to examine the effect of a configuration change or recalibration on the registry. 

CONTENT

The Content up/down control selects the amount of detail that "view registry" shows. When Content is 3, everything is shown. When Content is 2, edge calibration data is not shown. When Content is 1, only configuration data is shown. Often this is the only information of interest. The Content level does not affect "save registry", which always shows all information. The "view registry" button toggles. If the display window is closed, pressing the button opens the window; if open, the button closes it.

ROTATE

The buttons in the Rotate group rotate the video display and all touchscreens to 0, 90, 180, or 270-degree orientation by invoking the EloApi function rotateAll (see EloApiCe.doc). The function argument combines the orientation with a flag requesting the driver to call the OS function ChangeDisplaySettingsEx to rotate the video display. 

Rotate is used primarily for testing, but it does write the registry value "Orient" under the touchscreen root directories (HKLM\HARDWARE\DEVICEMAP\TOUCH\SER and USB). However, it doesn't include the video rotate request flag in the data assigned to "Orient".

PRIORITY

The Priority up/down sets the normal priority level of the driver of the device indicated in the device selection box. If a serial device is indicated, the priority is assigned to the serial driver. If a USB device is indicated, the priority is assigned to the USB driver. EloTalk provides no means to set the "high priority" level because this characteristic is currently ignored.

Usually, the default priority of 109(d) does not require changing. However, the driver might be assigned greater priority (lower numeric value) to determine whether some observed behavior is related to priority. For example, as explained in EloApiCe.doc topic EloRegIdxPriority, increasing the serial driver's priority (lower value) was shown to not correct the problem of uncontrolled RCOH feedback when a desktop icon is double-clicked.

CLEANING MODE
The cleaning mode button puts the device indicated in the device selection box into cleaning mode. In this state, the touchscreen responds only to touch-hold, which takes it out of cleaning mode. The dialog provides this control for test and demonstration purposes.

APPENDIX A: BUILDING OS WITH ELO PROGRAMS

The components can be added to your target image in three ways, two as user projects and one as platform components. The latter requires rebuilding the platform and is less flexible. It should be used only if you are building a platform for distribution. If your product is not a platform, it is easier and quicker to add the components as user projects.

The quickest way to add the components is to insert them as existing projects, directly referencing their project (pbpxml) files. This is done for each component individually in Platform Builder by Project > Insert > Existing Project and pointing to the appropriate pbpxml file under c:\ wince500 (or wince600)\ eloTouch, for example c:\wince500\ eloTouch\ eloUsb\ eloUsb.pbpxml. All necessary output files will already exist under eloTouch and simply remaking the run time image adds the components to nk.bin. Similarly, a component can be removed by deleting it from the Workspace Files view  and remaking the run time image.

The components can also be added as user components in the Catalog. Instead of directly referencing them in the EloTouch directory, they are first added to the Catalog. From there they can be selected into any project. The only advantage that this affords is that it allows the components to be selected without having to know their origin (under EloTouch). The procedure is:

1. Set installation environment

1.1. Open your project in Platform Builder.

1.2. Open the project release directory (Build OS > Open Release Directory).

1.3. Change the directory to C:\ wince500 (or wince600)\ EloTouch (or alternate).

2. Invoke AddEloCat.bat to add Elo components to the Catalog.

3. Update the platform's Catalog

3.1. In Platform Builder, if the Catalog is not displayed, select View > Catalog.

3.2. Right-click in the Catalog window and select Refresh Catalog. This is very important. Platform Builder's Catalog does not automatically update. In the Catalog window under Third Party > Device Drivers > Touch, you should see eloUsb, eloSer, eloVa, eloTalk, and eloBeep. If you don't see these, the installation has failed.

4. Add components to OS/Project design. For each component that you want to add, right-click its icon in Platform Builder's Catalog window and select Add to OS Design. All components are independently selectable. As each component is selected, its icon appears in the OS Design View under Device Drivers > Touch and a grayed project appears for it under Projects. Remaking the run time image adds the components to nk.bin.

5. Removing components. A touchscreen component can be removed from the OS design by right-clicking its icon in the OS Design View > Device Drivers and selecting Remove Item from User-specified Catalog Item(s). Both this icon and its project companion will disappear from the Design View window. The project cannot be directly managed.

The components can be added to the Platform by following the Catalog procedure described above but then rebuilding the Platform instead of just remaking the run time image. This process cannot be easily reversed. Once the components have become part of the Platform, you can remove them by deleting them from your project and rebuilding the Platform but you cannot reintroduce them as user projects but only as Platform components unless all references to them are deleted from the Platform's pbxml file (by hand editing).

Touchscreen reg files (eloUsb.reg, eloSer.reg, and elova.reg) must be merged into the OS image. Platform Builder automatically merges the reg files of included components. You can edit these files directly and remake the run-time image to change touchscreen operating parameters initialized by registry entries.  

APPENDIX B: ELO TOUCHSCREEN REGISTRY VALUES

GENERAL NOTES

HKEY_LOCAL_MACHINE

All touchscreen registry keys are subkeys of HKEY_LOCAL_MACHINE. This is sometimes abbreviated as HKLM. The abbreviation cannot be used in the source reg files; Platform Builder requires the full name.

VALUE DATA

Touchscreen registry values comprise mostly DWORD and a few single strings. DWORD data is hexadecimal.

CONFIGURATION VS PARAMETER VALUES

EloTalk's "save registry" capability enables configuring the touchscreen operation of a CE target system interactively and transferring the resulting registry values to the OS design source files without fully understanding their meaning. However, most of the configuration values are easily understood and may be edited by hand. Parameter data, which is generated by Elova and EloTalk, is difficult to understand and is normally transferred to source files without modifying its content. However, most parameter data can also be understood and edited. Edge calibration data is opaque and cannot be successfully edited.

To emphasize the distinction between configuration and parameters values, configuration values are given camel notation names like "DragStepPost" while parameter values are given upper-case names like "SWAPXY"

TOUCH SOUND

[HKEY_LOCAL_MACHINE \HARDWARE\DEVICEMAP\TOUCH\SOUND] 

holds touch sound data and is normally defined in eloSer.reg or eloUsb.reg. Shared by all touchscreens.

DOWN UP RIGHT

Each of three events, down (touch), up (untouch), and right (click) can have no sound (default), beep ("Down|Up|RightBeep"), or wav file ("Down|Up|RightWav"). 

Beep value is dword with HIWORD=duration, LOWORD=tone, e.g. 

"DownBeep"=dword:00640BBA  ; duration = x0064(100) and  tone = x0BBA(3000)

Wav value is full path (with \\ for each \) to wav file name, e.g. 

"RightWav"="\\windows\\exclam.wav" 

DRAG

Drag sound is a tone that starts at a low frequency at initial touch and increases in frequency the further the touch moves from the initial point. This sound is available only if the system includes PC-like tone hardware and EloBeep.dll is included in the OS design.

"DragTone" combines starting tone in HIWORD and limit (lowest tone = highest frequency) in LOWORD, e.g.

"DragTone"=dword:07D00190 ; start=x07D0(2000), limit=x190(400)

"DragStepPost" combines step in HIWORD and post in LOWORD, e.g.

"DragStepPost"=dword:00640014 ; step=x0064, post=x0014(20)
 

ELOVA

[HKEY_LOCAL_MACHINE \Hardware\Devicemap\Touch\Elova]

holds calibration program timeouts and is normally defined in eloVa.reg. The edges that Elova presents for edge calibration (if any) are selected by "EdgeCalCfg" under the key of each touch device. Also under this key are "EdgeTarget", which defines target offset from edges for Elova's edge calibration, and "CalStore", which defines the storage location of calibration data. 

The timeout key values are "VaTime1", "VaTime2", and "VaTime3", setting, respectively, the first touch, intra-touch, and accept/reject timeouts. Each value is a hexadecimal dword in seconds. A value greater than 0xFFFF is interpreted as infinite, which should only be used, if at all, for the initial touch delay. The default values are 0x14, 0x10, and 0x14, for an initial delay of 20 (decimal) seconds, intra-touch delay of 10 seconds, and accept/reject delay of 20 seconds. e.g.

"VaTime1" = dword: 14 ; Initial timeout. Default 20d (14h) seconds. 

"VaTime2" = dword:0A ; Timeout between target touches. Default 10d (0Ah) seconds.

"VaTime3" = dword:14 ; Timeout to accept or reject. Default 20d (14h) seconds.

TOUCHSCREEN DRIVER SYSTEM VALUES

These are required for the OS to properly invoke the touchscreen drivers.

SERIAL DRIVER SYSTEM VALUES

[HKEY_LOCAL_MACHINE \Drivers\BuiltIn\EloTouch]

    "Dll" = "eloSer.Dll"

    "Prefix" = "ELO"

    "Order" = dword:F  ; Load order 0 (earliest) to 255 (latest)

    "FriendlyName" = "Elo Serial Touch Screen"

USB DRIVER SYSTEM VALUES

[HKEY_LOCAL_MACHINE\Drivers\USB\LoadClients\1255\Default\3\EloUsbTs] 

    "DLL"="eloUsb.DLL"

[HKEY_LOCAL_MACHINE\Drivers\HID\LoadClients\1255\Default\1_1\eloUsbTs]

    "DLL"="eloUsb.DLL"

[HKEY_LOCAL_MACHINE\Drivers\HID\ClientDrivers\eloUsbTs]

   "DLL"="eloUsb.DLL"

   "Prefix"="ELO"

TOUCHSCREEN CONFIGURATION AND OPERATION VALUES

Serial and USB have the same configuration and operation registry values except as noted.

[HKEY_LOCAL_MACHINE \Hardware\Devicemap\Touch\USB]

This is the root key for all USB touch devices and is normally defined in eloUsb.reg. If the system contains multiple USB monitors then the "Multimon" value in this root determines how they will use the registry. If "Multimon" is 0, they all share the root. If "Multimon" is 1, the first device uses the root. If "Multimon" is 2, the first device uses the T1 key under the root, i.e.

 [HKEY_LOCAL_MACHINE \Hardware\Devicemap\Touch\USB\T1]

Unless "Multimon" is 0 or undefined, the second USB device uses the T2 subkey of the root, the third the T3 subkey, etc.

[HKEY_LOCAL_MACHINE \Hardware\Devicemap\Touch\Ser]

This is the root key for all serial touch devices and is normally defined in eloSer.reg. If the system contains multiple serial monitors then the "Multimon" value in this root determines how they use the registry. If "Multimon" is 1 then the first device uses the root. If "Multimon" is 2, the first devices uses the T1 key under the root, i.e.

[HKEY_LOCAL_MACHINE \Hardware\Devicemap\Touch\Ser\T1]

Subsequent devices use the T2, T3, etc. subkeys of the root. They cannot share the root. If "Multimon" is assigned 0, only the first device will be recognized.

SPECIAL SERIAL VALUES

"ComPort" string tells the real or virtual port name. e.g. "ComPort"="COM1:". Note that the trailing semicolon is required.

"HWHandShaking" tells whether hardware handshaking is used (non-0 value data) or not (0). e.g. "HWHandShaking"=dword:1

ROOT VALUES

These are located only in the root key and apply to the driver rather than to each device. Serial and USB are distinct.

"Orient" tells the initial video orientation.

0 = 0, 1 = 90, 2 = 180, 3 = 270 (degrees counter-clockwise).

Set bit 9 to tell the driver to rotate the display (by calling the OS function ChangeDisplaySettingsEx)

e.g. "Orient"=dword:101 rotates the touchscreen parameters and the display to 90.

Default is not undefined.

"Priority256" and "HighPriority256" are the normal and elevated driver priorities. Lower number is higher priority. The driver enforces minimum 3, maximum 255. Actual priority is not automatically set by the OS (as it would be if these values were located under HKLM\Drivers\BuiltIn\Touch) but by the driver invoking the OS function CeSetThreadPriority. The "HighPriority256" value is not currently used.

Default is 6D (109d) for both.

CONFIGURATION VALUES FOR EACH TOUCH DEVICE

"OnTouch" tells how touch events are reported. 0 disables reporting.


1 (default) reports system mouse. 2 reports mouse events through API.

"MouseMode": 0 = click on touch, 1 = click on untouch,   2 (default) = mouse emulation (with drag)

"AntiBounce" is the minimum time (in msec) that an untouch must persist in order to be recognized. Minimum 0, maximum 775, default 0.

"TouchTick" is hold timer resolution. e.g. "TouchTick"=dword:64 ; 0x64 = 100 msec per tick.

"HoldJiggle" is the hold perimeter in absolute touch units. Movement inside this is considered to be the same as the original touch point. e.g. "HoldJiggle"=dword:400

"UntouchTickCount" is the number of ticks to count before forcing untouch to protect against lost untouch and cable disconnect. 0 disables. e.g. "UntouchTickCount" = dword:0

"HoldEventTick" is the tick count to simulating right click. 0 disables. e.g. "HoldEventTick"=dword:8

"HoldShowTick" is the tick count before showing right-click countdown visual feedback 0 means immediate feedback. >= HoldEventTick means no feedback. e.g. "HoldShowTick"=dword:1

"HoldShowStep" is right-click countdown visual feedback step size in pixels. e.g. "HoldShowStep"=dword:6

CALIBRATION CONFIGURATION (per device)

Calibration operation values tell Elova and the touchscreen drivers what kinds of calibration data to gather and subsequently use. These are intelligible and can be devised by hand.

"EdgeCalCfg" bits 0 through 3 tell Elova whether to present for calibration left, top, right, or bottom edges, respectively. This is used only by EloVa but is uniquely defined under each touchscreen because different touchscreen may not require the same edges calibrated. In contrast, Elova timeouts, which are the same for all touchscreens, are defined under the Elova key. If "EdgeCalCfg" is 0, Elova disables its Calibrate Edges button. e.g. "EdgeCalCfg"=dword:A tells Elova to present the top and bottom edges.

"EdgeTarget" defines target offset from edges for both Elova edge calibration (for linearity correction) and corner acceleration. This is in touchscreen points. Typically 1/2 small icon. e.g. "EdgeTarget"=dword:E


"CalStore" low nibble = src, high = dest. 1 = controller, 2 = registry, 3 = both.

Set b9 to flush registry (RegFlushKey) after writing 3pt and/or edge cal.

e.g. "CalStore"=dword:131 means read from controller, write to registry with flush and to Controller.

"EdgeAcc" bytes 0-3 select edge acceleration for XLO, YLO, XHI, YHI. 

0 = off. 1 = on. 2 = default. e.g. "EdgeAcc"=dword:0

"LinCor" bytes 0-3 select linearity correction for XLO, YLO, XHI, YHI. 

0 = off. 1 = on. e.g. "LinCor"=dword:0

"LinCorType" tells the type of linearity correction for the touchscreen. 

0=unknown, 1=none, 2=generic correctible type, 3=specific type. e.g. "LinCorType"=dword:2

"CornerAcc" 0 disables all corner acceleration, non-0 enables. e.g. "CornerAcc"=dword:0

CALIBRATION PARAMETERS

Calibration State

Most touchscreens require calibration via elova. Elova returns an exit code that tells its general execution status but not whether any individual touchscreen was fully or partially calibrated. Elova indicates the calibration status of each touchscreen by writing to the "Cal" value under that device's registry key. If fully calibrated, that is three-point and edge if requested by EdgeCalCfg, elova assigns 2 to "Cal". If partially calibrated (only three-point is done but EdgeCalCfg is non-zero) elova assigns 1. If skipped, elova does nothing to "Cal", allowing the touchscreen's existing calibration status to remain.

Three-Point Calibration

Three-point calibration parameters result from executing Elova's standard three-point calibration. They may be stored in the registry and/or the controller (as instructed by "CalStore"). They can be edited by hand with a thorough understanding of the relationship between the video and touchscreen.  

"SWAPXY" tells whether or not the touchscreen and video display have the same orientation or are rotated 90 degrees. Non-zero means that they do not have the same orientation. e.g. "SWAPXY"=dword:0

"VIDX", "TSDX", "OFFX", "VIDY", "TSDY", and "OFFY" describe the numerical relationship between the X and Y axes of the touchscreen and video display. e.g.

"VIDX"=dword:CCCC
; 52428

"TSDX"=dword:8E5

; 2277

"OFFX"=dword:FFFFC8F6
; 4294953206(-14090)

"VIDY"=dword:CCCC
; 52428

"TSDY"=dword:FFFFF7F0
; 4294965232(-2064)

"OFFY"=dword:14AA9
; 84649

Edge and Corner Acceleration

Edge and Corner Acceleration parameters result from excuting EloTalk's Calibration Test. They may also be edited by hand but the actual data is in the touchscreen domain rather than video and is difficult to comprehend. They are stored in the registry by the system developer. They don't require adjustment and no end-user means is offered to change them. 

"BXL", "BYL", "BXH", "BYH" touchscreen coordinates of video border (edges).

"APXL", "APYL", "APXH", "APYH" touchscreen position of edge acceleration inner border.

"ARXL", "ARYL", "ARXH", "ARYH" edge acceleration rates.

"CYLXL", "CYLXH", "CYHXL", "CYHXH" corner acceleration rates (0 = no acceleration).

Edge Calibration

Edge calibration parameters result from excuting Elova's Edge Calibration. These values are always stored in the registry. The value names are "ECx" and "EPx", where x is a decimal number. The data has no human-intelligible meaning.

